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Description 
 
Model LC10S15ADC-MC, for use with LiPo, Li-Ion, A123, NiCd, NiMH, and Pb battery packs 
 
10s Multi-Chemistry, 15 Amp, 600W model for automatic and manual charging with available high-power 
balancing, overcharge protection, and automatic charge/discharge to storage (for Li batteries) 
 
 
Features 
 

 Charges Lithium Polymer, Lithium Ion, A123, NiCd, NiMH, and Pb packs.  Charges any brand of 
pack. 

 Supports high-power balance charging of Li or A123 battery packs.  Balance charges one 1s to 10s 
pack, or two 1s to 5s LiPo packs simultaneously.  When two packs are connected, the balance 
connections and pack main discharge wires are wired in series by the charger. 

 Equipped with Cellpro brand (JST PA series times two, 6 position) balance connectors which enable 
the charger to monitor and independently charge each cell to its optimum level (balance charge 
operation). 

 Accepts Cellpro 10s Adapters for plug-and-play compatibility. Cellpro 10s Adapters support from 2s 
to 6s battery packs (all brands).  For more information on REVO adapters, visit 
http://www.revolectrix.com/cellpro_adapters.htm   

 Backward-compatibility with older Cellpro 4s adapters is assured using the available 6-pin to 5-pin 
adapter(s) (REVO PN: CP10S-5S/4S-ADP-US) for charging 2s to 4s Cellpro packs having 5-pin 
balance connectors. 

 Also supports customer-selectable, XH mode.  JST XH/EH balance connectors and wiring are 
growing to be the dominant scheme in the industry.  Switching to XH mode, the CP10XP can support 
existing XH style adapters you may already own.  Splice in REVO PN: CPBP6P-10-US battery 
pigtails to the wires on existing adapters and you are good to go! 

 Supports non-balanced charge of Li (up to 2s), Ni (up to 28 cells), Pb (up to 24V), A123 (up to 12s). 
 Accepts 10-32 VDC input. 
 Up to 15A max charge current. 
 Maximum 25A input current 
 720W max continuous input and 605W max continuous output at 30V DC input.  Charger will achieve 

rated output to a 10s LiPo using 30V DC input.  Increasing input voltage beyond 30V does increase 
power output, but only if the charger’s output voltage exceeds 42V; e.g., when charging 12s non-
balanced A123 packs.  However, 32V DC input is a maximum rating.  It is recommended to utilize 
input voltage slightly below the absolute maximum. 

 Supports AUTO rate charging (1.0C, 2.0C, and 3.0C charge rate) using Advanced Fuel Gauging 
technology, or manual set currents of 0.10A – 15A in 0.10A increments. 

 Industry’s largest 1A proportional integrated balancers 
 Power-balance-charge packs through balance connectors in tandem with the main discharge wires of 

the battery pack(s).  Unit does not support balance-connector only charging. 
 Compensates for balance wire lengths up to six feet with 1mV accuracy.  
 Displays individual cell internal resistance to 0.1milliohm, for estimating pack quality, health, and 

performance. 
 Storage Preset available to charge or discharge Li batteries to appropriate per-cell storage levels; 3.8v 

(LiPo), 3.0v (A123). 
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 During discharge to storage, the CP10XP incorporates 1A-per-cell (nominal) discharge rate using the 
charger’s integrated balancing circuitry to provide up to 42W (at 10s) discharge power. 

 Light-grey, 2 line, 16 character backlit LCD display provides easy readability. 
 One button, Charge Optimization can be set for an Accurate 1mV cell balance and (C/20 termination) 

or for Faster Charging (less balancing accuracy and C/10 termination) using the Charge Control 
Software or at the CP10XP interface. 

 Protects your Pb input source from over-discharge by providing an audible warning when input 
voltage of your Pb battery approaches 50% state of charge. 

 Intelligent controller performs extensive checks to prevent damage to packs and power supply.  This 
makes it virtually impossible to damage the charger or the batteries from incorrect connections or 
wiring; including, but not limited to reverse polarity. 

 Input reverse-polarity protection. 
 Simple, effective, 2-button interface allows instant access to presets, preset parameters, and starting 

and stopping charger operations. 
 Access pre-defined, named presets by clicking the MODE button. 
 Hold the MODE button to access the Main Menu operations:  Choose Chg. Amps, Choose Chemistry, 

Show Help Screen, Exit.  Use the charger’s Main Menu to alter basic settings of presets on-the-fly, or 
make the adjustments using the free PC Charge Control Software (CCS). 

 Press and hold the START/STOP button to start charger operation or cancel/end a charging session. 
 Press and hold MODE button during power up to access Options Menu; choose input amps limit and 

supply low voltage setting (Power Management feature), alternate between FMA or XH balance 
wiring schemes, and set quiet charging (no speaker beeps during charging). 

 Supports Bi-directional, optional PC interface (REVO PN: FUIM2-US or FUIM3-US) which enables 
extensive charger setup using the CCS.  Configure up to 10 custom presets, adjust speaker volume, 
set LCD contrast and control many other settings. 

 CCS automatically checks for software and charger firmware updates in the background.  Update 
charger firmware reliably with the click of your mouse button, and without sending the charger back 
to the factory.  Keep up-to-date with the latest enhancements and bug fixes. 

 6 different, available Fuel Gauge lookup tables (fuel tables) may be assigned to independent presets 
to match the characteristics of different Li battery chemistries.  This feature only available using the 
CCS. 

 Works with a wide range of power supplies, even those not rated for high power.  Easily changes 
from moderate current bench supply at home to car battery at the field using the Power Management 
feature.  Set Input supply amps limit and supply low voltage settings using the CCS or at the charger 
interface, to prevent damage to your input source. 
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Precautions 
 

 Follow all instructions in this manual to assure safe operation. 
 IMPORTANT:  Do not disconnect or connect packs while the charger is charging. 
 Always watch LiPo packs while they are charging.  Never leave LiPo packs unsupervised during 

charging. 
 See additional warning sheets provided with your battery packs. 
 Follow all guidelines for charging, discharging, handling and storing LiPo cells. 
 Minor arcing may occur when discharge wires are connected to the charger before charging.  This is 

normal. 
 
 
 

Parts 
 

 Cellpro 10XP Charger 
 Removable input plier clips (red/black) for connecting the CP10XP to a DC power source 
 Optional:  FUIM2-US or FUIM3-US PC USB Adapter (required for using the Charge Control 

Software) 
 Optional:  Cellpro 6-pin to 5-pin Adapter(s) 
 Optional:  Cellpro 10s Adapters (brands other than REVOLECTRIX Cellpro) 
 Optional:  CP10S-BP12-2PK-US, Cellpro 10s Banana Plug Output Cables (2 pack) – solder the 
mating end of the connector you use on your battery’s discharge wires to these cables 

 
Notes: 
 
You may have already received some of the optional items listed above with the purchase of a Combo. 
 
Unless otherwise stated, REVOLECTRIX part numbers found within this manual assume purchase was or 
will be made within the United States.  If ordering from the International website, drop the “-US” from 
the part number. 
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Charger terminology 
 

To DC 
Power
Supply

DisplayConnect FUIM2 or FUIM3
PC USB Interface here when
connecting to Charge Control Software
(black wire toward outside wall of case)

Channel 1 Channel 2

Banana jacks for discharge
wires when charging

2 packs at the same time

Use two outer banana jacks for discharge
wires when charging only one pack.
Never connect pack discharge wires
across the two yellow banana jacks.

This will result in blowing the internal fuse.
Note the skull and crossbones

warning between the yellow jacks!

MODE button

START/STOP button

Channel 2
balance connector

Channel 1
balance connector
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Pack terminology and configurations 
 
REVOLECTRIX Cellpro branded 5s battery packs 

Balance connector,
Cellpro brand

(JST PA series)
6 position

Discharge wires:
Red = Pack positive
Blk = Pack negative

5s REVOLECTRIX packs like
the one shown above will connect

directly to the Cellpro 10XP charger
without requiring any additional adapter  

 
REVOLECTRIX Cellpro branded 2s, 3s, and 4s battery packs 

Balance connector,
Cellpro brand

(JST PA series)
5 position

Discharge wires:
Red = Pack positive
Blk = Pack negative

2s to 4s REVOLECTRIX packs like
the one shown above require the

5s-to-4s adapter for interconnection
to the Cellpro 10XP charger

(REVO PN: CP10S-5S/4S-ADP-US)  
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REVOLECTRIX Cellpro branded 6s-9s battery packs 
 

Balance connector,
Cellpro brand

(JST PA series)
5 position

Discharge wires:
Red = Pack positive
Blk = Pack negative

6s-9s REVOLECTRIX packs like
the one shown above require the

5s-to-4s adapter for one of the 
balance connectors for inter-

connection to the Cellpro 10XP charger

Balance connector,
Cellpro brand

(JST PA series)
6 position

 
 
 
Note:  Other brands of batteries will require Cellpro 10XP Adapters.  For more information on REVO 
adapters, visit http://www.revolectrix.com/cellpro_adapters.htm 
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Understanding the Cellpro 10XP Charger 
 
Auto Charging vs. Manual Current Settings 
When balance charging Li batteries, you can set the Cellpro 10XP Charger’s charge rate to one of three 
AUTO modes—1.0C, 2.0C or 3.0C—as appropriate for the pack(s) being charged.  When one of these 
rates is selected, the charger determines the pack’s capacity (over time) and automatically sets the 
correct output current using FMA’s advanced Fuel Gauging technology.  The accuracy of AUTO 
charging depends on how well your battery’s charge curve matches up with the fuel table being used by 
the CP10XP.  Six different fuel tables are available to support different Li battery chemistries and may 
be assigned to individual presets using the Charge Control software.  Factory presets for LiPo batteries 
are set up for a generic, 15C battery profile.  AUTO charging using the default presets may or may not 
be accurate for your batteries.  The advantage to using AUTO charging is that you do not need to think 
about or even know the true capacity of your batteries.  You can charge different capacity batteries at 
different times without having to adjust the charge rate setting and the charge will automatically adjust 
to choose the appropriate charge rate.  You just tell the CP10XP how fast you want to charge, and it 
does the work for you.  For safety reasons, AUTO charging current is capped at 6A, regardless of the 
size of the pack being charged.  You can also manually set charge current to any value between 0.1A 
and 15A in 0.1A increments.  Finally, you can select Storage Charge mode which automatically charges 
or discharges to the appropriate per-cell storage voltage for LiPo or A123 batteries. 
 
Power and Charging Speed 

Cellpro 10XP Charger Power Chart
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When one pack is connected to the charger, the pack is initially charged at the selected charge rate (or 
the maximum charge rate possible).  Using Ohm’s law, the maximum charge rate (Amps) is derived 
from the maximum power (Watts) the charger can produce without overheating. 
Maximum output power will normally reach approximately 605W when charging a 10s LiPo battery 
using a 30V DC input power source, and assuming the input source can deliver a maximum of 720W of 
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clean power to the charger input.  Maximum power depends on many factors including pack imbalance 
during charge, input (supply) voltage, output (charge) voltage, DC/DC converter efficiency, which 
varies between 80% and 95% depending on the relationship of supply voltage-to-charge voltage, 
ambient temperature, and internal operating temperature.  From the graph, you can see that Increasing 
input voltage beyond 30V does increase power output, but only if the charger’s output voltage exceeds 
42V; e.g., when charging 12s non-balanced A123 packs.  However, 32V DC input is a maximum rating.  
It is recommended to utilize input voltage slightly below the absolute maximum. 
When the pack reaches about 95% capacity, the charger enters balance charge mode.  Charge current 
tapers off, but will remain at 1A or higher until the pack voltage slows the current to 1/20th C (Constant 
Voltage Mode).  When the pack reaches 99% capacity, the charger beeps three times.   The pack can be 
removed to use, or allowed to continue charging until it is 100% full and the charger displays “Charge 
Complete.” 
During the entire charge process, the charger power balances the pack using 1A current until all cell 
voltages are within 1mV of each other.  Power balancing is the process of beginning the balancing 
process early in the charge cycle using high-current shunts to drain excess cell voltage while other cells 
in the pack have a chance to catch up.  Power balancing means the pack tops off faster and the total 
charge time is greatly reduced.  This is possible because the balance circuitry is internal to the charger.  
Automatic temperature control and an integral fan ensure the charger never exceeds maximum safe 
operating temperature under any conditions.  The result is faster, safer charging. 
When charging two packs, the packs are connected in series (the balance connections as well as the 
main charge wires).  In effect, the charger treats the two packs as a single pack.  For example, if you 
connect a 3s pack and a 4s pack, the charger operates on them as one 7s pack.  If the pack capacities are 
different for the two packs connected, the charge rate should be selected based on the lower capacity 
pack.  Initially, the packs are charged at the selected charge rate (or the maximum charge rate possible) 
until one pack becomes fully charged—however, the charger can handle cell balancing of the two packs 
completely independently.  The second pack continues to charge at a minimum 1A rate until it is full 
and balanced. 
Notice that one of the packs in a simultaneously-charged pair is always topped off at a minimum rate of 
1A (dictated by the maximum balance current available).  If the packs have the same capacity, and were 
discharged to about the same level, both packs will charge in less than 30 minutes at 3C.  However, if 
the packs have different capacities, or were discharged to different levels, charging for the pair could take 
longer than expected.  Since the charger supports a high power balance current of 1A, all other things 
being equal, the charger still outperforms competing brands.  In most instances, by the time the first pack 
is fully charged, the second pack is already approaching constant voltage charge mode; the battery pack 
itself is the limiting factor in charge time, not the charger. 

Example 1:  You are powering an aircraft with two 4s 2100mAh packs connected in series.  
Because those packs have the same capacity, and were discharged to about the same level 
during flight, you can expect them to charge in about the same time.  It would be appropriate 
to charge them simultaneously using the Cellpro 10XP Charger. 
Example 2:  You are powering one aircraft with a 3s 500mAh pack, and other aircraft with a 
5s 5000mAh pack.  If you charge these packs simultaneously using the Cellpro 10XP Charger, 
it would probably take a long time (the 500mAh pack would become full first, then the 
charger would switch to its 1A balancing rate to fill up the 5000mAh pack, which could take 
several hours).  In this case, it would be faster to charge these packs separately because the 
charger can then apply optimum (and substantially different) charge currents to each pack. 

In some cases, such as Example 2, it will be faster to charge two packs separately rather than 
simultaneously.  It’s up to you to decide, based on what you know about their respective capacities and 
discharge states. 
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In Example 2 above, when the 500 mAh pack reaches 99% capacity (the charger beeps three times), it is 
a simple matter to remove the pack from the charger and continue charging the 5000 mAh pack at a 
higher charge rate.  Here’s how: 
 
1. Connect both packs and start charging them using an AUTO or manual rate setting. 
2. Watch the fuel level display.  When one pack reaches 99% fuel level, stop charging. 
3. Disconnect the full pack. 
4. If the partially charged pack is connected to Channel 2, move it to Channel 1. 
5. Continue charging the partially-charged pack. 

 
About Factory Presets 
During all phases of the charge process, the charger will balance all the cells in Channel 1 and Channel 2 
together as one big pack, and report the fuel level of two packs being charged as one big pack.  The 
exception to this is if you use one of the Factory presets (or set up a custom preset) containing the words 
“Dual Channels”.   In this case, the CP10XP will balance all the cells in Channel 1 against each other and 
all the cells in Channel 2 against each other, and report the fuel level of the two packs independently. 

 
Power Management Feature 
The charger will draw up to 25A to deliver its 15A maximum output current.  The high input current is 
required when the input voltage must be boosted to drive packs having larger numbers of cells in series.  
Output power is determined by several factors, including battery pack imbalance during charge, input 
voltage, input current, output voltage, ambient temperature, and the charger’s internal temperature. 
The charger’s DC-to-DC converter is typically 80% to 95% efficient.  Highest efficiency occurs when 
the input voltage is higher than the output voltage needed to charge the connected pack(s).  However, 
the charger cannot tolerate input higher than 32V DC.  Supplying input voltage of 30V provides the 
highest efficiency, coolest operating temperature and fastest charging times, especially when charging 
packs containing more than five cells in series. 
You can also manually limit the charger’s input current and adjust the supply low voltage limit so the 
charger will not draw more power than the supply can provide.  If you know your power supply is rated 
for 3A output, for example, you can limit the charger’s input current to 3A.  (Be aware that limiting 
charger input current may increase pack charge times.)  If you are using a Pb battery to power the 
CP10XP and you do not want to discharge below a certain voltage, you can set it where you want it.  
When the charger is powered from a high current source (such as a car battery), you can adjust the 
current limiting to provide maximum pack charging current.  Details for changing these settings are 
provided in sections “Options Menu Explained” as well as “Limiting charger input current” under 
“Using the Charge Control Software”.  The Factory Default settings for the Power Management feature 
are as follows: 

1. Input Supply Current Limit: 25A 
2. Input Supply Low Voltage Limit:  11V 
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Connecting packs to the charger 
 
General information 

 When balance charging, both a balance connector and the main discharge wires must be connected to 
the Cellpro 10XP. 

 When performing a non-balance charge on a 2s Li, A123, NiCd, NiMH, or Pb pack, connect only the 
pack’s main discharge wires to the two outer banana jacks on the charger’s front panel. 

 When charging only one pack, always plug that pack’s balance connector into the charger’s Channel 
1 balance port and always connect the main discharge wires to the charger’s outermost banana jacks. 

 When charging two packs simultaneously, make sure to correlate each pack’s balance connector and 
pack discharge leads to the same charger Channel.  For example, first pack’s balance connector in 
Channel 1 balance port, first pack’s discharge leads to Channel 1 banana jacks (the left two jacks).  
Second pack’s balance connector in Channel 2 balance port, second pack’s discharge leads to 
Channel 2 banana jacks (the right two jacks). 

 When charging two packs, both packs must have the same chemistry.  For example, you can’t charge 
one A123 pack and one LiPo pack at the same time.  Never mix chemistries under any circumstances. 

 
WARNING:  Failure to comply with the above could result in fire and/or damage not covered by warranty! 

 
 Pack discharge wires are usually not terminated in banana plugs (e.g., they might be terminated in a 

Deans connector).  For convenience in connecting to the charger, prepare an adapter cable with 
banana plugs on the charger end and a connector that mates with the pack’s discharge connector on 
the other end.  Revolectrix sells banana plugs suitable for this purpose as REVO PN:  CP10S-BP12-
2PK-US, Cellpro 10s Banana Plug Output Cables (2 pack). 

 
CAUTION:  When using the banana plug adapter cables described above, ALWAYS insert the banana 
plugs into the charger BEFORE connecting the adapter cable to the pack.  Reverse the sequence when 
disconnecting the pack.  This will prevent the live banana plugs from touching each other, which would 
create a dangerous condition and could seriously damage the pack. 

 
Connecting non-Cellpro packs 
Generally, follow the instructions in “Connecting one 1s to 10s Cellpro pack” and “Connecting two 1s 
to 5s Cellpro packs” below, but your packs may not be equipped with compatible balance connectors.  
REVOLECTRIX offers plug-and-play adapters for charging LiPo packs equipped with balance 
connectors made by other manufacturers.  Check http://www.revolectrix.com/cellpro_adapters.htm for 
adapter compatibility.  The Cellpro 10XP Charger works with all existing Cellpro 4s charger adapters.  
You must connect a 6-pin to 5-pin Adapter (REVO PN: CP10S-5S/4S-ADP-US) between the charger 
and the Cellpro 4s charger adapter, as shown here: 
 

 
 
If an adapter isn’t available for the pack you want to charge, or if the pack doesn’t have a balance 
connector, the REVOLEXTRIX PN CPBP7-US (Cellpro battery pigtail 10”, 5 position) and/or PN 
CPBP6P-10 (Cellpro battery pigtail 10”, 6 position) cable assemblies can be used to make the pack 
compatible with the Cellpro 10XP Charger.  Instructions for connecting these cable assemblies to your 
packs are provided in the “Cellpro Pin Lead Connection” document at: 
http://www.revolectrix.com/support_docs/item_1315.pdf    
 
Note: see also “Balance connector wiring” later in this manual. 
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Connecting one 1s to 10s REVOLECTRIX Cellpro pack 
1. How you connect the Cellpro pack’s balance connector(s) to the charger depends on the pack’s 

configuration.  Use the photos in the section “Pack terminology and configurations” above, then find 
the configurations in the diagrams below and connect as shown in that diagram. 

 

 

 
2. When charging a single pack, plug the discharge wires into the outermost banana jacks. 
 

 

 
Connecting two 1s to 5s Cellpro packs 
1. How you connect the Cellpro packs’ balance connectors to the charger depends on the packs’ 

configurations.  Use the photos in the section “Pack terminology and configurations” above, then find 
the configurations in the diagrams below and connect as shown in that diagram. 
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2. When charging two packs simultaneously, connect the discharge wires into the banana jacks as shown 

below. 
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Applying power to the charger 
 

 To apply power to the charger:  Connect the charger to a 10V to 32V DC power supply, field battery 
or car battery.  If your bench power supply is equipped with banana jacks for output, you can remove 
the plier clips from the charger’s input cables and plug the cables directly into the power supply jacks. 

 
When the charger is powered up, it displays the following “Welcome” screen: 
 

Cellpro 10XP 
[firmware version]* 

 
Press the MODE button one time to advance to the “Preset Menu” 
 

Preset 1 
[chem] [BAL] @ [charge current]* 

 
Press the MODE button repeatedly to scroll through and view/select the Cellpro 10XP’s 10 presets, 
one at a time. 

*Information in square brackets varies. 
 
Introduction to presets 
As shipped from the factory, the charger has ten presets.  The presets are displayed in the “Preset Menu” 
and display in the charger’s LCD as follows: 

Preset Name/Settings Description 
Preset 1 
LiPo BAL @ 1.0C 

Designed for a single 1s-10s LiPo battery, balance 
charged at AUTO 1.0C. 

P2 Dual Channels 
LiPo BAL @ 1.0C 

Designed for two, 1s-5s LiPo batteries, balance 
charged at AUTO 1.0C. 

Preset 3 
LiPo BAL @ STORE 

Designed to automatically storage charge or discharge 
LiPo batteries to 3.8v per cell for safe storage.  
Preset will charge using AUTO 1.0C or discharge using 
1A internal balance circuits. 

Preset 4 
LiPo 2sU @ 1.0A 

Designed for one 2s LiPo, unbalance charged at 1.0A 
manual rate setting. 

Preset 5 
A123 BAL @ 4.6A 

Designed for 1s-10s A123 battery, balance charged at 
4.6A manual rate setting. 

P6 Dual Channels 
A123 BAL @ 4.6A 

Designed for two, 1s-5s A123 batteries, balance 
charged at 4.6A manual rate setting. 

Preset 7 
A123 2sU @ 4.6A 

Designed for one 2s A123, unbalance charged at 4.6A 
manual rate setting. 

Preset 8 
NiCd 8mV @ 1.0A 

Designed for 1-26 cell NiCd, non balance charged, peak 
detection, 8mV fallback at 1.0A manual rate setting. 

Preset 9 
NiMH 5mV @ 1.0A 

Designed for 1-26 cell NiMH, non balance charged, peak 
detection, 5mV fallback at 1.0A manual rate setting. 

Preset 10 
LEAD 12V @ 3.0A 

Designed for 12V Lead Acid Battery, non balance 
charged at 3.0A manual rate setting. 

 
When power is applied, the charger always initializes to the last preset used for charging.  If you altered 
the charge settings for a preset at the charger (as described in “Changing a preset,” later in this manual), 
those changes are retained when the charger is disconnected from power, and will be reapplied when the 
charger is powered up again. 
“Selecting a preset” and “Changing a preset,” in the next section, provide additional information. 
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Note:  If you programmed the charger using the Charge Control Software, different presets may be 
available.  Also, if you have been using the software, you may have given the factory presets different 
names.  Bottom line: if you change settings at the charger, or redefine presets, you probably won’t see the 
factory presets shown above.  To revert back to the original factory settings above, initiate a Factory 
Restore using the CCS, Presets tab. 

 
Operating the charger 
 
You operate the charger using the MODE button and START/STOP button on the right side of the 
charger.  This simple, effective, 2-button interface allows instant access to presets, preset parameters, as 
well as starting and stopping charger operations. 
 

 MODE button:  enables you to view/select a preset, change preset parameters and display charging 
data during charging. 

 START/STOP button:  enables you to start charging after you have selected a preset, and to stop or 
cancel a charging session at any time.  The START/STOP button also allows you to toggle back and 
forth between Accurate and Faster Charge optimizations (applicable to LiPo and A123 battery packs 
only). 

 
Overview of button operations: 
Following is an overview of all possible functions available using these buttons.  These functions are 
listed in the approximate order you might use to traverse the CP10XP. 

 
 At start up, press the MODE button to access and scroll the Preset Menu and to view/select pre-

defined, named presets and their settings, one at a time.  A preset is considered “selected” when its 
name and settings are listed on the charger’s LCD. 

 At any time prior to starting a charge operation, press and hold the MODE button to access the 
Main Menu options:  Choose Chg. Amps, Choose Chemistry, Show Help Screen, Exit.  
While watching the scrolling menu options, continue holding the MODE button, then, release it 
only when you see the menu option you want.  Now you may use the charger’s menu to alter 
parameters of presets on-the-fly.  Note: Preset parameters are permanently saved the instant they are 
changed. 

 When inside of Main Menu options, press the MODE button to change preset parameters. 
 When changes to preset parameters are complete, press and hold the MODE button to access the 

Main Menu again.  Then choose Exit to return to the Preset Menu. 
 Press the START/STOP button to toggle back and forth between Accurate vs Faster Charge 

optimization.  This feature available only when a LiPo or A123 balanced preset is selected. 
 Press and hold the START/STOP button (for 1 second) to start charger operation or cancel/end a 

charging session. 
 At any time while charge is in progress, press the MODE button to view real-time operating 

information and charging data. 
 
Special Button Operation: 

 Press and hold MODE button while applying power to access and scroll the Options menu: CHOOSE 
SPLY AMPS, LOWS SUPPLY VOLTS, NODE CONNECTOR, QUIET CHARGING, Exit.  Use the Options 
Menu to choose input amps limit and supply low voltage setting (Power Management feature), 
alternate between FMA or XH balance wiring schemes, and set quiet charging (no speaker beeps 
during charging). 
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Performing Common Tasks: 
 
Selecting a preset 

 At start up, press the MODE button to access and to scroll the Preset Menu and view/select pre-
defined, named presets and their settings, one at a time. 

The preset displayed when you stop pressing the MODE button is the “selected” preset.  Once the preset 
is selected, you can change the parameters for this preset (see “Changing a preset”) or begin charging by 
pressing and holding the START/STOP button (for one second). 
 

Note:  The Charge Control Software enables you define up to ten custom presets.  Using the CCS, you 
can change the names of the Factory Presets, or change any of the available parameters associated with 
each preset.  If you have defined custom presets, you can—at the charger—select any preset.  (If you 
have not defined custom presets, the factory presets are available.) 

 
Changing a preset 
You can change the charge parameters for the currently selected preset to match the characteristics of 
the pack(s) you are charging. 

 
 At any time prior to starting a charge operation, press and hold the MODE button to access the 

Main Menu options:  Choose Chg. Amps, Choose Chemistry, Show Help Screen, Exit.  
While watching the scrolling menu options, continue holding the MODE button, then, release it 
only when you see the menu option you want.  Now you may use the charger’s menu to alter 
parameters of presets on-the-fly.  Note: Preset parameters are permanently saved the instant they are 
changed. 

1. Select the preset you want to change (see “Selecting a preset,” above). 
2. At this point, there are several things you can do: 

 To change the charge current: 
a. Press and hold the MODE button, then release it when the display changes to this: 

Choose Chg. Amps 
Hold for More 

 
Note:  If you hold the MODE button down longer, you’ll see Choose Chemistry,etc (described 
below) 

 
 When you release the MODE button, you’ll see the charge current of the selected preset: 

Choose Chg. Amps 
Charge @ [current] 

 
b. Then: 

 Press the MODE button about once per second to increase current in 0.1A steps. 
 Press the MODE button quickly twice to increase current to the next whole Amp. 
 When the maximum current is reached, press the MODE button once for each of the 

following three AUTO charge modes or STORAGE charge mode: 
 1.0C (where C = pack’s capacity) 
 2.0C 
 3.0C 
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 STORE (to charge or discharge pack to 50% capacity; optimum for long-term storage) 
 (Return to manual charge current settings at 0.1A) 

 
Note:  The charger’s AUTO charge fuel gauge tables are optimized for Lithium Cobalt batteries.  If you are 
charging Lithium Manganese batteries, AUTO charge modes may not be accurate.  Manual current 
settings are recommended when charging Lithium Manganese batteries.  Use the CCS to assign the 
appropriate fuel gauge table to your presets to improve the accuracy of AUTO charge mode. 

 
 To change the chemistry: 

a. Press and hold the MODE button, then release it when the display changes to this: 
 

Choose Chemistry 
Hold for More 

 
Note:  If you hold the MODE button down longer, you’ll see Show Help Screen, etc (described 
below). 

 
 When you release the MODE button, you’ll see the chemistry setting: 

Choose Chemistry 
[chemistry] [BAL] [voltage] 

 
 

b. Press and release the MODE button until you see the chemistry you want.  Choices are: 
 

Chemistry/Charge Mode Description 
LiPo BAL 4.20V LiPo Balance Charge to 4.20V per cell 
LiPo BAL 4.22V LiPo Balance Charge to 4.22V per cell 
LiPo BAL 4.10V LiPo Balance Charge to 4.10V per cell 
A123 BAL 3.65V A123 (or LiFe) Balance Charge to 3.65V per cell 
NiCd 8mV Fall Bk NiCd Unbalance Charge, Peak Detect, 8mV Fallback 
NiMH 5mV Fall Bk NiMH Unbalance Charge, Peak Detect, 5mV Fallback 
LEAD 6V Lead Acid Charge to 6V 
LEAD 12V Lead Acid Charge to 12V 
LEAD 18V Lead Acid Charge to 18V 
LEAD 24V Lead Acid Charge to 24V 
LiPo 1sU 4.20V LiPo Unbalance Charge, 1s to 4.20V 
LiPo 2sU 8.40V LiPo Unbalance Charge, 2s to 8.40V 
A123 1sU 3.65V A123 (or LiFe) Unbalance Charge, 1s to 3.65V 
A123 2sU 7.30V A123 (or LiFe) Unbalance Charge, 2s to 7.30V 
A123 3sU 10.95V A123 (or LiFe) Unbalance Charge, 3s to 10.95V 
A123 4sU 14.60V A123 (or LiFe) Unbalance Charge, 4s to 14.60V 
A123 5sU 18.25V A123 (or LiFe) Unbalance Charge, 5s to 18.25V 
A123 6sU 21.90V A123 (or LiFe) Unbalance Charge, 6s to 21.90V 
A123 7sU 25.55V A123 (or LiFe) Unbalance Charge, 7s to 25.55V 
A123 8sU 29.20V A123 (or LiFe) Unbalance Charge, 8s to 29.20V 
A123 9sU 32.85V A123 (or LiFe) Unbalance Charge, 9s to 32.85V 
A123 10sU 36.50V A123 (or LiFe) Unbalance Charge, 10s to 36.50V 
A123 11sU 40.15V A123 (or LiFe) Unbalance Charge, 11s to 40.15V 
A123 12sU 43.80V A123 (or LiFe) Unbalance Charge, 12s to 43.80V 

 
 To get help using the Cellpro 10XP:  Press and hold the MODE button, then release it when the 

display changes to this: 
Show Help Screen 
Hold for More 
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Note:  If you hold the MODE button down longer, you’ll see Exit,etc (described below) 
 

Press the MODE button repeatedly to scroll the Help Screen information 
 

 To Exit the Main Menu and return to the Preset Menu:  Press and hold the MODE button, then 
release it when the display changes to this: 

Exit 
Hold for More 

 
Note:  You may press and hold the MODE button from any place within the menu to change menu 
options or select Exit.  Remember, any changes you make while in the Main Menu are saved the instant 
you make the changes.  If you hold the MODE button down longer, you’ll see the previous Main Menu 
options described above. 

 
   or 
 
 To Quick Start a Charge (Exit the Main Menu and begin charging in one operation if a pack is 

connected): Press and hold the START/STOP button for one second.  Details are provided in the 
next section. 

 
Charging a pack or packs 
1. Before charging, pack(s) must be properly connected to the charger.  See “Connecting packs to the 

charger,” earlier in this manual for details.  Also, the correct preset must be selected for the packs 
connected to the charger.  See “Selecting a preset”, earlier in this manual for details. 

2. Press and hold the START/STOP button for one second to enter Charging Mode. 
3. You will see the following screens in sequence: 

PLEASE WAIT… 
 

 
CHRGING LiPo BAL 
MODE for info. 

*above screen will vary depending on what preset is being used 
Note: because the CP10XP supports automatic storage charge/discharge to 50%, the initial LCD 
indication may show DSCHGING for up to 10 seconds, even if a charge was initiated.  This is normal. 

4. While in Charge Mode, you can take the following actions: 
 To view pack and operating data:  Press the MODE button repeatedly to cycle through the 

following screens.  (These examples assume two packs are being charged using one of the Dual 
Channel presets; if one pack is being charged, only the top line may appear in some screens.) 

 
C 1.00A 00:00:59 
Supply=12.2V/ 3A 

Charge current and charge time. 
Supply voltage and input current. 

 
[prese  t name]
[chem] [BAL] @ [charge current] 

Selected preset. 
Preset’s charging settings. 

 
[chemistry] [BAL] [charge process] 
[chemistry] [BAL] [charge process] 

Chemistry and charge process (Fast 
Charging, Balance Charging, etc.) in effect 
for each channel. 
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Ch1 Fuel = 47% 
Ch2 Fuel = 55% 

Results of unique FMA algorithm that 
determines pack “fuel level.”  Data is also 
used to calculate correct C rate during 
1/2/3C charging. 

 
Ch1 Pack = 15.772V 
Ch2 Pack = 15.761V 

Total pack voltage(s). 

 
Ch1    42mAh In 
Ch2    40mAh In 

mAh put back into pack(s) during charging. 

 
1:3.956V 2:3.956V 
3:3.956V 4:3.956V 

Individual cell voltages.*  “:” indicates Ch1 

    screen auto scrolls to show all cells: 
5=3.966V 6=3.966V 
7=3.966V 8=3.966V 

Individual cell voltages.*  “=” indicates Ch2 

 
1:12.3mΩ  2:13.2 
3:12.1mΩ  4:14.2 

Individual cell internal resistances in 
milliohms.*†  “:” indicates Ch1 

    screen auto scrolls to show all cells: 
5=11.8mΩ  6=13.5 
7=12.4mΩ  8=12.6 

Individual cell internal resistances in 
milliohms.*†  “=” indicates Ch2 

 
*Cells are numbered from 1 through n, where 1 is the first cell in the pack connected to Ch1, and n is the last cell in the pack 
(if only one pack is being charged) or the last cell in the pack connected to Ch2 (if two packs are being charged). 

†For the charger to calculate internal resistances, pack must be at less than 80% fuel level at start.  Internal resistances will 
be available for display after about 12 minutes of charging, and will be periodically updated after that. 

 
5. Note, when you press and hold the START/STOP button to initiate a charge or storage operation 

(step 2 above), you are actually starting a charge “session”.  During a session, the data is logged to the 
charger’s memory, the LCD, and to the CCS (if connected to the PC).  When the charger is allowed to 
finish the operation, the LCD will read, e.g., LiPo [BAL] DONE 
 
 To end the charge session and clear logged data:  Press the START/STOP button for one second.  

The charger flashes CHARGER STOPPED then displays the Preset Menu. 
Note:  Pack data is lost when you end the charge session, so if you want to see it, cycle through the saved 
data by pressing the MODE button before pressing and holding the START/STOP button. 

 
 To cancel charging at any time:  Press and hold the START/STOP button for one second.  The 

charger flashes CHARGER STOPPED then displays the Preset Menu. 
Note:  Pack data is lost when you end the charge session, so if you want to see it, cycle through the saved 
data by pressing the MODE button before pressing and holding the START/STOP button. 

 
Options Menu Explained 
In addition to the charger’s Preset Menu, and Main Menu, there is also an Options Menu available for 
altering basic charger settings using the charger’s interface.  The Options Menu is accessed by pressing 
and holding the MODE button while you power up the charger. 
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Note: In addition to the Options Menu items described below, the CCS allows access to these and other 
charger options on the Options tab. 

 
1. Press and hold the MODE button while you power up the Cellpro 10XP. 
2. Continue holding the MODE button; the charger will enter the Options Menu and immediately start 

to cycle through the following menu items; CHOOSE SPLY AMPS, LOW SUPPLY VOLTS, NODE 
CONNECTOR, QUIET CHARGING, Exit.  Release the MODE button only when the LCD reads the 
setting you want to change or press and hold the MODE button again to begin cycling through the 
Options Menu items again.  If you accidentally release the MODE button when the LCD reads Exit, 
begin again at step 1 above. 

3. At this point, there are several things you can do: 
 To change the charger’s input supply current (amps) limit (Power Management feature): 

a. Press and hold the MODE button, then release it when the display changes to this: 
 

CHOOSE SPLY AMPS 
Hold for More 

 
Note:  If you hold the MODE button down longer, you’ll see LOW SUPPLY VOLTS, etc (described 
below). 

 
 When you release the MODE button, you’ll see the current supply amps limit setting: 

CHOOSE SPLY AMPS 
Limit @ [current amps setting] 

 
b. Press and release the MODE button until you see the current limit setting you want.  Choices 

range from 1A to 25A in 1A increments. 
 
Note:  to protect your power supply from overload, make this setting approximately 10% lower than the 
max current rating of your input supply.  Factory Default for this setting is 25A.  But realize that reducing 
the supply current limit below 25A will extend charge times. 

 

 To change the charger’s input supply low voltage limit (Power Management feature): 
a. Press and hold the MODE button, then release it when the display changes to this: 

LOW SUPPLY VOLTS 
Hold for More 

 
Note:  If you hold the MODE button down longer, you’ll see NODE CONNECTOR?, etc (described 
below). 

 
 When you release the MODE button, you’ll see the input supply current low voltage limit 

setting: 
LOW SUPPLY VOLTS 
Limit @ [volts] 

 
b. Press and release the MODE button until you see the input supply low voltage limit setting 

you want.  Choices range from 10V to 28V in 0.1V increments. 
 
Note:  Press the button about once per second to select 0.1V increments.  Press the button faster to scroll 
in 1V increments.  10V is the Factory Default setting and is the lowest input voltage for safe operation of 
the CP10XP; however, you may choose to raise this voltage to protect your input supply.  For example, 
you should avoid operating at lower than 11 or 11.5V using a 12V Pb battery as input as over-discharge 
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will severely shorten the life of the input battery. 
 

 To toggle the charger between FMA and XH balance (node) connector wiring: 
a. Press and hold the MODE button, then release it when the display changes to this: 

NODE CONNECTOR? 
Hold for More 

 
Note:  If you hold the MODE button down longer, you’ll see Quiet Charging, etc (described 
below). 

 
 When you release the MODE button, you’ll see the currently selected balance connector wiring 

mode: 
NODE CONNECTOR? 

>[mode] 

 
b. Press and release the MODE button to toggle operation between FMA NODE WIRING or 
XH/EH WIRING 
 
Note:  FMA NODE WIRING is the Factory Default mode and provides proper operation when using FMA 
or REVOLECTRIX Cellpro branded batteries with JST PA series connectors.  XH/EH WIRING mode 
supports the popular JST XH or EH wiring scheme.  See the section “Balance Connector wiring” below for 
more information about these wiring schemes. 
 

 To set the charger for QUIET CHARGING: 
a. Press and hold the MODE button, then release it when the display changes to this: 

QUIET CHARGING? 
Hold for More 

 
Note:  If you hold the MODE button down longer, you’ll see Exit, etc (described below). 

 
 When you release the MODE button, you’ll see the setting for QUIET CHARGING: 

QUIET CHARGING 
>[Y/N] 

 
b. Press and release the MODE button to turn QUIET CHARGING OFF or ON. 

 
Note:  When QUIET CHARGING is turned ON, the charger will not beep to notify you at 99% charge 
completion or when the charge is completed.  Setting QUIET CHARGING to YES does not disable the 
speaker during button presses.  This may be accomplished only using the CCS on the Options tab. 
 

 To Exit the Options Menu and return to the Preset Menu: 
a. Press and hold the MODE button, then release it when the display changes to this: 

Exit 
Hold for More 

 
Note:  If you hold the MODE button down longer, you’ll see CHOOSE SPLY AMPS, etc (described 
above). 

 
 When you release the MODE button, you’ll see the Preset Menu: 
Preset 1 
[chem] [BAL] @ [charge current] 

 22



 
Note:  Remember, any settings you change while in the Options Menu are automatically saved the instant 
you make the change.  You may Exit the menu at any time.  You may also simply cycle power to the 
charger to re-start, in which case the Welcome Screen will appear. 

 
Alternate charging modes 
Based on what the charger determines about charging conditions, it may enter one of these charging 
modes automatically (as indicated in the display): 
 In Low Voltage Restore Mode, the charger automatically attempts to repair an over-discharged pack.  Cells 

discharged as low as 0.5V may be repaired to as much as 98% of capacity. 
 In Safety Charging Mode, the charger detects that at least one cell is seriously out of balance, and 

automatically lowers charge current to 0.5A. 
CAUTION:  If the charger’s display shows SAFETY CHARGING during several attempts at charging, 
the pack is damaged.  Treat damaged packs with caution.  Do not charge them on a flammable surface, 
and do not charge them unattended.  Never repeatedly START a charge on a pack that continuously 
triggers SAFETY CHARGING.  Fire may result! 

 
 In Cold Weather Balancing Mode, unlike previous FMA chargers, the Cellpro 10XP does not 

support reduced end of charge voltage based on ambient or operating temperature. 
 

If the charger detects a problem, it will stop charging and display a safety code.  If this happens: 
1. Press the MODE button to reset the charger. 
2. Reconnect the battery properly. 
3. Press the START/STOP button to continue charging. 
 
See the “Troubleshooting” section for more information 
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Using the Charge Control Software 
 
The Cellpro 10XP Charge Control Software (CCS) enables you to define presets, save and load groups of 
presets, update the charger’s firmware, and control various aspects of the charger’s options. 
 
Installing the Charge Control Software 
For detailed information on installing the Cellpro 10XP CCS, please visit the Cellpro 10XP Product 
Tabbed page at www.revolectrix.com (from the main chargers page, locate and click the charger’s 
image) then click the “Resources” tab. 

 
Launching the Charge Control Software 
1. Start > All Programs > FMA Direct > Cellpro 10XP. 
2. If your computer is connected to the Internet, after you launch the application, the program will check 

to see whether a new version is available.  If a new version is available, it will automatically 
download in the background.  The next time you launch the application, you will have the option to 
install the new version or launch the version you already have. 

3. If an update to the CCS is available, it may carry with it a newer firmware version.  If new firmware 
is available, a message will appear; click OK to close the message window.  See “Updating charger 
firmware,” later in this manual, for instructions. 

 
Connecting the charger to your computer 
* The Cellpro 10XP CCS is a free download.  But to actually connect the charger to the PC and use the 

application you will require either the FUIM2-US or FUIM3-US PC USB Interface. 
1. Follow all of the install directions on the CCS install page.  Do not attempt to connect the FUIM2-

US/FUIM3-US to the PC or to the charger until you have successfully installed the product’s USB 
driver.  Follow these instructions. 

2. If the Charge Control Software isn’t running, launch it now. 
a. Click Download USB Driver link at the bottom the CCS window. 
b. Choose the correct PC interface version (FUIM2-US/FUIM3-US) driver version and run the 

installer. 
c. Restart your computer if prompted. 

3. Now plug the FUIM2-US/FUIM3-US USB plug into your computer.  Windows should locate the 
device and load the driver you just installed. 

4. Now power up the charger and plug the 3-pin connector into the jack on the charger’s left side.  The 
black wire should be toward the bottom of the charger’s panel. 

5. With COM port set to “Auto” (CCS lower left corner) watch the message line just below the 
program’s menu bar. 
 If “Waiting to Start” appears, everything is working properly and you are ready to use the program. 
 If “Checking Com COMx for data” or “No Data from 10XP Charger” doesn’t go away, the 

program can’t communicate with the charger.  To correct this, unplug the PC interface from the PC 
and the charger and begin again at Step 1 above.  If problem persists, check the FAQ page at 
www.revolectrix.com or check the “Support Options” section below. 

 
Monitoring charging operations 
 To monitor cell voltages, total pack voltage and related charging parameters during charging:  

Click the Cells tab. 
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 To monitor cell internal resistances during charging:  Click the Int. Res. tab. 
 

Note:  For the charger to calculate internal resistances, pack must be at less than 80% fuel level upon 
charge start.  Internal resistances will be available for display after about 12 minutes of charging, and will 
be periodically updated after that. 

 
 To view cell parameter graphs:  View > Graphs.  In the Graphs window: 

 To view cell volts:  View > Cell Volts. 
 To view pack volts:  View > Pack Volts. 
 To view current:  View > Amps. 
 To view internal resistance:  View > Internal Resistance. 
 To view fuel level:  View > Fuel. 
 To print a graph:  File > Print. 

 
NOTE:  Depending on the preset selected, not all Graphs will contain data. 

 
Limiting charger input current 
The charger will draw up to 25A to deliver its 15A maximum output current.  The high input current is 
required when the input voltage must be boosted to drive packs having larger numbers of cells in series.  
The charger monitors input current from the power supply, and automatically reduces pack charge 
current if it determines that the power supply can’t keep up. 
You can also manually limit the charger’s input current so the charger will not draw more power than 
the supply can provide.  If you know your power supply is rated for 3A output, for example, you can 
limit the charger’s input current to 3A, or slightly lower.  This feature prevents damage to power 
supplies, such as bench supplies, having low to moderate output currents.  (Be aware that limiting 
charger input current may increase pack charge times.)  When the charger is powered from a high 
current source (such as a car battery), you can set manual current limiting to a higher level.  Factory 
default setting for input current limiting is 25A. 
Additionally, the input supply low voltage limit can easily be adjusted.  The Factory Default setting is 
10V which ensures safe operation of the charger.  But in some cases you may wish to increase this input 
voltage limit; e.g., to prevent a 12V Lead Acid input supply battery from being over-discharged.  Most 
Pb batteries will experience greatly reduced life-span if discharged below 11V or 11.5V. 
 To monitor supply voltage:  Click the Supply tab. 
 To manually set input current limiting:   

1. In the Supply tab, select the desired maximum current in the Current Limit dropdown list. 
2. Click the Update Charger button. 

 To manually adjust supply low voltage limiting:   
1. In the Supply tab, select the desired minimum input voltage in the Supply Low Voltage Limit 

dropdown list. 
2. Click the Update Charger button. 

 To set the CP10XP to warn you when a 12V or 24V input supply Lead Acid battery is at 50% depth of 
discharge, check the Warn 50% DOD checkbox. 

 To manually adjust Input Current Limit or Supply Low Voltage Limit at the field without using the 
Charge Control Software, see the section “Options Menu Explained” above. 

 
Defining presets 
On the Presets tab, you can define and name up to ten charger user presets using the CCS.  Each preset 
consists of a name, a chemistry, a charge current, a Fuel Table (Li chemistry only), and whether or not 
the preset supports Dual Pack Charging (track balancing and capacity independently on Ch1/Ch2).  See 
“Selecting a preset,” earlier in this manual, for instructions on selecting a preset for charging. 
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Note:  Remember that presets can be overridden at the charger.  Preset changes made at the charger are 
retained in the charger until manually changed again, or until a new group of presets is downloaded to the 
charger.  When you connect the charger to the computer and launch the Charge Control Software, the 
program uploads and displays the presets stored in the charger. 

 
Perform all preset operations in the Presets tab. 
 To define a preset: 

1. In the Name field, enter a name (or new name) for the preset. 
2. In the Chemistry field, select the chemistry.  In addition to basic battery chemistry, “Chemistries” 

encompass charge voltages, balance options, and manual cell counts when applicable. 
3. In the Amps field, select the charge current, either AUTO 1C, 2C, 3C, STORE, or manual set rate. 
4. If this preset will be used to charge two 1s-5s packs simultaneously, you may choose to activate the 

Dual Channel option (this enables the charger to treat Ch1 and Ch2 as completely separate packs 
for purposes of balancing, fuel gauge readout, and capacity readouts). 

 To download presets to the charger:  Click Update Charger.  The charger will beep when 
downloading is complete. 
 or 
To ignore changes and restore the previous presets:  Click Cancel. 

 To restore the factory settings:  Click Factory Default, then click Update Charger. 
Note:  This restores the Factory Default presets, and also resets all charger options listed on the “Options” 
tab as well as the “Supply” tab to Factory Defaults.  Restoring Factory Defaults does not alter the currently-
installed Firmware level. 

 
Setting charger options 
1. Click the Options tab. 
2. Set options as desired: 

 LCD Contrast sets the contrast of the charger’s LCD.  The display will be easier to read in bright 
conditions when the contrast is high. 

 Auto Scroll Status Screens option, when checked, directs the charger to scroll through multiple 
screens during charging.  Delay controls how long each screen is displayed. 

 Speaker Volume controls the loudness of the charger’s speaker.  If you want the charger to 
confirm when you press the MODE button and START/STOP button, activate the Button Clicks 
ON option.  Deactivate the Speaker ON option to mute the charger.  Select Quiet Charging to 
prevent the charger from beeping when charger reaches 99% fuel or when charge process 
complete. 

 Optimize for Accurate Balance balances cells to 1mV and C/20 charge termination.  The charger 
can take an additional two to thirty minutes to balance the cells, depending on the state of 
imbalance present between cells.  Optimize for Faster Charging reduces balancer accuracy and 
terminates charge at C/10 to speed up the overall charging time. 

3. Click Update Charger. 
 or 
If you don’t want to apply the changes, click Cancel. 

 
Recording charge data 
The Charge Control Software can record charge data for each charging session. 
1. Press the START/STOP button on the charger to start a session. 
2. When prompted, enter a file name.  You can enter a file name you previously used, but you must 

confirm that you want to overwrite older data. 
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Charge data is stored in a semicolon-delimited format, which can be imported into a spreadsheet for 
analysis. 
 
Updating charger firmware 
1. If your computer is connected to the Internet, after you launch the application, the program will check 

to see whether a new version is available.  If a new version is available, it will automatically 
download in the background.  The next time you launch the application, you will have the option to 
install the new version or launch the version you already have. 

2. If an update to the CCS is available, it may carry with it a newer firmware version.  If new firmware 
is available, a message will appear; click OK to close the message window. 

When you are ready to update the charger: 
1. Be sure the charger is connected to the computer, and is powered up. 
2. Disconnect all packs from the charger. 
3. In the Charge Control Software window, switch to the Firmware tab. 
4. Select the firmware you want to download. 
5. Click Update Firmware. 
6. Wait—and do nothing—until updating is complete. 
 

IMPORTANT:  During firmware downloading, do not disconnect the charger from power, do not disconnect 
the charger from the computer, and do not exit the Charge Control Software.  If the firmware update is 
compromised for any reason, disconnect the PC interface from the charger and from the PC, re-boot the 
computer, cycle power to the charger, then repeat steps 1 – 6 above. 
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Balance connector wiring 
 
When using FMA WIRING mode (Factory Default Setting) 
The following diagrams shows how a 6 pin Cellpro (JST PA series) balance connector (REVO PN 
CPBP6P-10-US) must be wired to a 5s, 4s, 3s, 2s, and 1s battery pack when the Cellpro 10XP is set to 
FMA WIRING mode (Factory default). 

 

Pin 1

Red

Black

Pack positive
Node 4
Node 3
Node 2
Node 1
Pack negative

5s Pack
Pack positive

(red), 18.5V*

Node 4, 14.8V*

Node 3, 11.1V*

Node 2, 7.4V*

Node 1, 3.7V*

Pack negative
(blk), 0V

Cell 5

Cell 4

Cell 3

Cell 2

Cell 1

* Nominal voltage with
 respect to pack negative  

FMA Cellpro Connector/FMA Wiring Mode 

Pin 1

Red

Black

Pack positive

Node 3
Node 2
Node 1
Pack negative

4s Pack
Pack positive

(red), 14.8V*

Node 3, 11.1V*

Node 2, 7.4V*

Node 1, 3.7V*

Pack negative
(blk), 0V

Cell 4

Cell 3

Cell 2

Cell 1

* Nominal voltage with
 respect to pack negative  

FMA Cellpro Connector/FMA Wiring Mode 
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Pin 1

Red

Black

Pack positive

Node 2
Node 1
Pack negative

3s Pack
Pack positive

(red), 11.1V*

Node 2, 7.4V*

Node 1, 3.7V*

Pack negative
(blk), 0V

Cell 3

Cell 2

Cell 1

* Nominal voltage with
 respect to pack negative  

FMA Cellpro Connector/FMA Wiring Mode 

Pin 1

Red

Black

Pack positive

Node 1
Pack negative

2s Pack
Pack positive

(red), 7.4V*

Node 1, 3.7V*

Pack negative
(blk), 0V

Cell 2

Cell 1

* Nominal voltage with
 respect to pack negative  

FMA Cellpro Connector/FMA Wiring Mode 

Pin 1

Red

Black

Pack positive

Pack negative

1s Pack
Pack positive

(red), 3.7V*

Pack negative
(blk), 0V

Cell 1

* Nominal voltage with
 respect to pack negative  

 
NOTE:  In the above FMA wiring scheme, when the battery has fewer than 5 cells, the red wire always 
connects to Pack positive, and the unused balance (node) wires are left un-connected from the battery.  
Always remove unused wires from the Cellpro battery pigtail by gently lifting each pin’s locking tab with a 
hobby knife, and pulling the wire free of the housing. 
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When using XH/EH WIRING mode 
These diagrams show how a 6 pin Cellpro (JST PA series) balance connector (REVO PN CPBP6P-10-
US) must be wired to a 5s, 4s, 3s, 2s, and 1s battery pack when the Cellpro 10XP is set to XH/EH 
WIRING mode.  You may choose to set the CP10XP to XH MODE and splice the CP 6 position to an 
XH adapter you already own.  Use this illustration to guide you. 

 

Pin 1

Red

Black

Pack positive
Node 4
Node 3
Node 2
Node 1
Pack negative

5s Pack
Pack positive

(red), 18.5V*

Node 4, 14.8V*

Node 3, 11.1V*

Node 2, 7.4V*

Node 1, 3.7V*

Pack negative
(blk), 0V

Cell 5

Cell 4

Cell 3

Cell 2

Cell 1

* Nominal voltage with
 respect to pack negative  

FMA Cellpro Connector/XH and EH Wiring Mode 

Pin 1
Black

Pack positive
Node 3
Node 2
Node 1
Pack negative

4s Pack

Pack positive, 14.8V*

Node 3, 11.1V*

Node 2, 7.4V*

Node 1, 3.7V*

Pack negative
(blk), 0V

Cell 4

Cell 3

Cell 2

Cell 1

* Nominal voltage with
  respect to pack negative  

FMA Cellpro Connector/XH and EH Wiring Mode 
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Pin 1
Black

Pack positive
Node 2
Node 1
Pack negative

3s Pack

Pack positive, 11.1V*

Node 2, 7.4V*

Node 1, 3.7V*

Pack negative
(blk), 0V

Cell 3

Cell 2

Cell 1

* Nominal voltage with
  respect to pack negative  

FMA Cellpro Connector/XH and EH Wiring Mode 

Pin 1
Black

Pack positive
Node 1
Pack negative

2s Pack

Pack positive, 7.4V*

Node 1, 3.7V*

Pack negative
(blk), 0V

Cell 2

Cell 1

* Nominal voltage with
  respect to pack negative  

FMA Cellpro Connector/XH and EH Wiring Mode 

Pin 1
Black

Pack positive
Pack negative

1s Pack

Pack positive, 3.7V*

Pack negative
(blk), 0V

Cell 1

* Nominal voltage with
  respect to pack negative  

 
NOTE:  In the above XH/EH wiring scheme, there are no un-used wires between any of the nodes and/or 
pack positive like the FMA wiring scheme.  Pack positive continually moves up by one with each additional 
cell added to the pack.  Always remove unused wires from the Cellpro battery pigtail by gently lifting the 
pin’s locking tab with a hobby knife, and pulling the wire free of the housing. 
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Estimating performance factors 
 
If you don’t have a way to directly measure your propulsion system’s electrical parameters, the Cellpro 
10XP Charger enables you to estimate them using before- and after-flight measurements. 
 
Collect data 

Charge pack. 
  
When charging is finished, record Fuel % and total pack voltage (i.e. sum of cell voltages). 
  
Fly plane (or test on the ground).  Record flight time in minutes. 
  
Connect pack to charger.  Record Fuel % and total pack voltage. 

 
Calculate performance factors 

 

 
 
 
Evaluate results 
 Average current during flight gives you a rough idea whether system components—ESC, motor, 

connectors and wiring—are operating within their current ratings.  Keep in mind that peak current 
during flight may greatly exceed the average current you calculated. 

 Watts per pound is an approximate indicator of aircraft performance (other factors influencing 
performance include lift, drag and motor type).  Here are some guidelines: 
 25 to 30 watts per pound:  level flight. 
 40 to 50 watts per pound:  take off from smooth surface, climb. 
 50 to 75 watts per pound:  take off from grass, sport aerobatics. 
 75 to 125 watts per pound:  pattern aerobatics. 
 Over 125 watts per pound:  3D. 
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 Specifications 
 
For battery type Lithium Polymer, Lithium Ion, Lithium Manganese, A123 (LiFEPO4), NiCd, 

NiMH, Pb packs 
Supported Cell Counts LiPo, LiIon, LiMg – 1s-10s balanced, 1s, 2s unbalanced 
 A123 (LiFEPO4) – 1s-10s balanced, up to 12s unbalanced 
 NiCd – up to 28 cells (non-balanced) 
 NiMH – up to 28 cells (non-balanced) 
 Pb (Lead) – up to 24V 
Pack capacity 100mAh to 65Ah (charge time limited to maximum of 12 hours) 
Input voltage 10 to 32VDC; low voltage limit selectable from 10V – 28V in 0.5V increments 

(Power Management feature) 
Input current Up to 25A; can be limited to 1A to 25A in 0.5A increments (Power 

Management feature) 
Power conversion 62.5kHz switcher operating at 80% - 95% efficiency 
Per-Cell output voltage LiPo, LiIon, LiMg – 4.10V, 4.20, or 4.22V 
 A123 (LiFEPO4) – 3.65V 
 NiCd – 1.20V 
 NiMH – 1.20V 
 Pb (Lead) – 2V 
Output current 100mA - 15A*, reverse polarity protected 
Discharge current 1A per cell nominal (42W max) for storage discharging Li 
Cont. output current 234W @ +12V DC input; 645W @ +32V DC input 
Cell balancing Resolution 78uV (16 bit) for 1s-10s Li or A123 LiFEPO4) balanced charging 
Voltage calibration Cell voltage measurements are factory calibrated to a standard traceable to 

NIST; calibration is to ± 6 mV 
Current calibration Charge current is factory calibrated on a 4A standard; calibration is to ± 1mA 
Measurement accuracy Voltage resolution: 78 uV (16 bit) 
 Voltage tolerance: ± 6 mV 
 Charge current:  ± 1% 

Capacity added to pack:  ±1% 
Percent capacity (“Fuel”):  ±10% (with accurate fuel table defined in preset) 

Internal resistance 0.1mohm voltage resolution allows accurate four point internal resistance 
measurement of each cell 

Serial data output 19.2kbps, 8 bits, 1 start bit, 1 stop bit, no parity 
Data integrity Checksum, CRC checking 
Cooling fan Single, 8 CFM, 40mm diameter 
Heat Sink Aluminum case, finned 
Output connector “Cellpro” compatible, 2 x JST PA series, 6 position 
LCD 2 line, 16 character, light grey/blue backlit 
Size 6.83” x 3.67” x 1.70” 
Firmware updates Customer upgradeable using Charge Control Software (CCS) 

 
Footnotes: 
 
* Please note, for safety reasons, available charger current may be limited for certain battery types 
and/or charging modes, e.g., non-balanced charge of Li 
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Quick start for the Cellpro 10XP Charger 
 

Refer to m r complete operating details. anual fo
 

. Connect pack(s) to cha
 Plug pack’s balance ht side of the charger (use balance 

connector adapters a
rging only
 outermost

arging two d plug 
 wires from

 unba n accordance with bullet 

. Configure charger: 
 To review selected preset’s settings:  Press MODE button. 
 To select a different ODE button until you see the desired preset’s name and 

display. 
mistry and/or 

/STOP b

 button for one second. 
. The charger will autom initiate a series of beeps when charging is 

complete. 
G. To end charging sessio

A. Connect charger to a 12V to 32V (maximum) power source. 
B rger. 

connector(s) into channel jack(s) on rig
s needed). 

 When cha  one pack, plug pack’s balance connector into Ch1.  Plug pack’s discharge 
wires into  banana jacks on charger’s panel. 

packs:  Plug discharge wires fro When ch m Ch1 pack into banana jack pair #1, an
discharge  Ch2 pack into banana jack pair #2. 

 When using an lanced preset, connect only the pack discharge wires i
points 2 and 3 above. 

C

preset:  Press M
settings in 

 To change selected preset’s settings:  Press and hold MODE button to set che
charge current.  Press and hold to exit. 

D. Press START utton for one second to begin charging. 
E. During charging: 

 To view charge data:  Press MODE button repeatedly. 
 To cancel charging at any time:  Press START/STOP

F atically stop charging, 

n and return to Preset Menu, press START/STOP button for one second. 

and 
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Troubleshooting 
 
There ar o a charger!  After the START/STOP button is 

ressed, a special battery checking sequence automatically checks every wire before initiating a charge.  
 issue. 

ages in the display.  To determine the problem, look up the description 
below
 
Me

e 26 ways to improperly connect two packs t
p
It is possible to get an unrelated safety code from a simple wiring
 
Operating errors appear as mess

.  Correct the error.  If errors continue, contact FMA Customer Service. 

ssage Problem 
Neg
Supply < 10 
Su
Supp n or thin wiring 
Ch
Chg. Cell is too high 

A pack was detected on channel 2 after starting charge 
Se ers on a series pack. 
Low Voltage Cell
Ce
Reve Check pack wiring 
No
Ch2 n’t identify the pack.  Check for correct node setting. 

.  Loose input connections. 
Check pack wiring 
Check pack wiring or dirty connectors 

Un ge on the node connector. 
Ch

Charge Timeout The pack is taking too long to charge 
Bad Amps Setting Charger safety check 
Amps Not Raising Check the banana wiring 
Bad Fuel Table # Corrupted preset.  Factory restore the charger 
Bad Lith Fuel Tb Corrupted preset.  Factory restore the charger 
A123 < 2.7V/CELL Cell low voltage 
A123 > 3.8V/CELL Cell high voltage 
Options Corrupt Factory restore the charger 
L.Supply V.Limit The supply voltage reached the cutoff 
No Auto Amps Auto amps are not allowed in some chemistries 
Chem Not Found Corrupted preset.  Factory restore the charger 
LIPO < 3.0V/CELL Cell low voltage 
LIPO > 4.2V/CELL Cell high voltage 
Set Amps >= 2A Lower the amps setting 
Bad Banana Tot V Check the connectors.  Clean the connectors. 
Preset is Blank Change presets or factory restore 
No Fuel Table Corrupted preset.  Factory restore the charger 
 

. Term. < 0V Check pack wiring 
Volts Input supply voltage is too low 

pply > 32 Volts Input supply voltage is too high 
ly Unstable Check for a loose supply connectio

2 No Add Up Check pack wiring or dirty connectors 
 Overvoltage 

C2 Pack Detected 
ries Chargers Check Pack wiring.  Check for 2 charg

 A cell is too low 
ll < 0.1V The cell voltage is too low on a cell 

rse Polarity 
de 10 < 0V Check pack wiring 

Bad S. Count Channel 2 could
System Softstart Check the power supply is big enough
2 Pack Con. Err. 
Ch1 No Add Up 

balanced Only Unbalanced charge detected volta
1 has no pack Check pack wiring or dirty connectors 

Positive < 0V Check bananas 
Butt Not Pressed The confirm chemistry mode button was not pressed 
Pack Detect CH1 Unbalanced charge detected voltage on the node connector 
Pack Detect CH2 Unbalanced charge detected voltage on the node connector 
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…table continued from previous page 

er 

r #81 Bad Pb charge setup 

try 

cell V out of range 

sum is bad 

t 

ber 

 
Fuel not None  Corrupted preset.  Factory restore the charger 
Fuel not LiPo  Corrupted preset.  Factory restore the charger 
Fuel not A123  Corrupted preset.  Factory restore the charg
 
Error #79 CH1CELLS out of range 
Error #80 CH2CELLS out of range 
Erro
Error #82 Trickle current above 1A 
Error #83 Bad starting chemis
Error #84 Bad Pb set voltage 
Error #85 Bad NiCd fallback 
Error #86 Bad A123 set voltage 
Error #88 CHECKPACK1 cell V out of range 
Error #89 CHECKPACK2 
Error #90 Unknown screen number 
Error #92 MUX number error 
Error #93 Calibration check
Error #94 Bad EEPROM write 
Error #98 Charger over curren
Error #99 Bad mode number 
Error #100 Temperature out of range 
Error #101 Bad EEPROM preset write 
Error #102 Bad chemistry num
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Support options 
 

For Sales Support on REVO
E olectrix.co

LECTRIX Brand Products: 
mail: sales@rev m 

or phone: (800) 343-2934 

Technical Supp e REVO Store: 
dsupport@revol

 
For Sales or ort on "Other Brands" in th
Email: bran ectrix.com 
 
T nformation abou ct you are considering purchasing: 
E

o request i t a REVOLECTRIX produ
mail: info@revolectrix.com 

o 00) 343-2934 
 
S eas: 
For technical support on a R  own 
T efunds or Excha
T arranty or non-
 
T upport via emai
E

r phone: (8

upport is also available for any of the following ar
EVOLECTRIX product you already

o request R nges of merchandise 
o request w warranty repair work 

o request s l: 
mail: support@revolectrix.com 

o 01) 668-4280 
 
T case directly on line for any of the above:
1 your account at  
2. Click the "My Account" t
3. Under Support, click "Co

. On the case form, enter a subject which contains the product name, part number, or description 
5. Type a message in the message field 
6. The fields on the top right of the form are optional 
7. Click Submit 
 
A customer representative will contact you via email. 

r phone: (3

o initiate a  
. Log on to  www.store.revolectrix.com

ab 
ntact Support" 

4
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ited warranty REVOLECTRIX lim
 
REVOLECTRIX warrants this product to be free of manu

ny defects covered by this wa
facturing defects for the term of one year from 

rranty occur, the product shall be repaired or 
rformance by REVOLECTRIX or an authorized REVOLECTRIX service 

ed to the original place of purchase. 

his warranty may be enforced only by the original purchaser, who uses this product in its original 
 for warranty 
aid, with an 

 Authorization (RMA) form to the service station designated by 
 an RMA, contact REVOLECTRIX.  If you purchased the unit directly from 

.usastore.revolectrix

the date of purchase.  Should a
replaced with a unit of equal pe
station.  Unit must be return
 
Limits and exclusions 
T
condition as purchased, in strict accordance with the product’s instructions.  Units returned

rvice center will be accepted for service when shipped postpservice to a REVOLECTRIX se
iseassigned Return Merchand

EVOLECTRIX.  To obtainR
REVOLECTRIX, you may also file a case on line at www  (US web store) or 
www.store.revolectrix.com (International web store) to start the RMA process.  If you purch
product from an authorized distributor or dealer, contact the distributor 

ased the 
or dealer for further instructions. 

 the use of this product. 
se, abuse, neglect, electrical surges, reversed polarity on 

r acts of God. 
structions supplied with the product. 

 shipment of the product either to the customer or from the customer for 
service (claims must be presented to the carrier). 

ration of the product by anyone other than an 

er installation or removal. 
out service and warranty repairs. 

This warranty does not apply to: 
 Consequential or incidental losses resulting from
 Damage resulting from accident, misu
connectors, lightning or othe

 Damage from failure to follow in
 Damage occurring during

 Damage resulting from repair, adjustment, or any alte
authorized REVOLECTRIX technician. 

s, or damage caused by improp Installation or removal charge
Call (301) 668-4280 for more information ab
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